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Comfort Web Server Module

Section 1   Overview and Specifications

Introduction to Comfort Web Server Module

The Comfort Web Server Module CWM01 is an add-on module which
allows Comfort to be connected to a Local Area Network as well as to
the Internet so that a browser can be used to view web pages in
Comfort. It comes with a RS232 interface and an Ethernet interface.
The embedded web server software is also built-in allowing web pages
representing a home, office or factory layout with alarm points and
appliances to be displayed on a browser. The activation of motion
detectors as well as opening and closing of doors and windows is
shown on the screen as they occur. The state of connected appliances
and lights is also represented. Clicking on a light or appliance will
change the state of the device (off to on and vice versa), and the
change in state is updated as it occurs. The security system can also be
armed to any mode (Away, Night, Day or Vacation) or disarmed by the
click of a button. Any alarm activation will be shown in a message box
or as a flashing icon. A network camera server on the local area
network can be linked to the web server to view the premises on the
Internet.

The web page can be customized by anyone with knowledge of HTML.
Several sample files and graphic images are provided as a reference to
jump start the application.

Connection to the Internet can be via a dial-up external modem
connected to the CWM serial port, so no computer is required to
provide Internet Access. Alternately, if a PC or router on the local
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area network has a permanent connection to the Internet (ISDN, ADSL,
cable modem or leased line), this can be used as a gateway for
Internet access.

Features
• Built-in Web Server with Linux Operating System
• Network Interface (RJ45 connector) 10 MB/sec
• RS232 Interface to external modem (modem not supplied) for dial-

up internet access without a PC
• Port mapping to allow camera servers to be accessed from same IP

address (maximum of 10 ports)
• Flash memory 8 MB for operating system, software and web pages,

DRAM 4 MB. Approximately 5 MB is used by the operating system, 3
MB left for web page design and graphics

• Sample graphic image files and designs provided in CWM and CD-
ROM

• Access by computer through the internet or through a local network

Specifications
Dimensions: 108 x 88 mm baseboard with web server

daughterboard (85 x 85 mm)

Power supply: 12V 30mA from Comfort (for baseboard)
7V 2A from External Power Supply adapter
(supplied, 100-250VAC input, 7VDC 2A adapter)

System Requirement

• Comfort system with firmware version “Outside or Action 4.204” and
above.

Required Operating Systems (for Browser)

• Windows 98, Windows 2000, Windows NT, Windows XP
• Windows Millennium Edition requires Sun Java Virtual Machine

Browser Requirement

• Internet Explorer 5.0 or later
• Netscape 6 and above
• Opera Browser 7.0 and above with Java
• Mozilla Firefox 1.0

Supported Protocols

• TCP/IP, HTTP, FTP, PPP
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Operating Environment

• 5 to 40 deg C
• 10% to 90% relative humidity non-condensing

Setup

Accessories Provided

• Universal Power Supply Adapter (100 to 250 VAC in, 7VDC, 2A out)
• “Crossover” Type Network Cable
• CWM CD-ROM and Manual
• 4-way cable for connection to Comfort

Connections

• JP2/2A – 12V/COM/KA/KB connector. Connected to 12V/COM/KA/KB
on Comfort.

• RJ45 connector on daughterboard. For 10BaseT Ethernet connection.

• RS232 connector on daughterboard. For connection to external
modem (not supplied).

Jumper Settings

• SW7 – set according to the ID of the UCM (see “UCM ID Switch”
settings).

Buttons

• SW1 – Reset button. This button reinitializes the CWM. It does not
change any parameters in Comfort.

LED Indicators
• D1 “RDY” (Green) should be on at all times when powered up.

• D2 “BUSY1” (Red) not used.

• D9 (Red) RS485 Transmit to Comfort.

• D10 (Green) RS485 Receive from Comfort.
• D11 (Green) RS232 Receive from Network
• D12 (Red) RS232 Transmit to Network
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ICs

• U1 – Microcontroller IC. Label indicates the firmware version number
“CWM 5.xx”.

• U5 – RS485 Interface to Comfort

UCM ID Switch
Comfort is able to support up to 8 UCMs. SW7 is a set of 3 headers which
is used to determine the ID, in accordance to the table below:

Table 1: ID Settings
ID SW7-A SW7-B SW7-C
1 Short Short Short
2 Open Short Short
3 Short Open Short
4 Open Open Short
5 Short Short Open
6 Open Short Open
7 Short Open Open
8 Open Open Open

By convention, UCM ID = 1 is used for uploading/downloading. The CWM
should be set to ID 2 or above so that any communication failure can be
reported by Comfort.

Press RESET (SW1) after changing the ID settings.

The number of UCMs in Comfigurator should be set to the highest UCM
number of the system including the CWM. This is the same as
programming Location 1672, according to the number of UCMs and
CWM connected. Press reset on Comfort after changing the number of
UCMs.

Java Virtual Machine (JVM)

As CWM uses the Java technology to communicate with the browser,
your computer must have the Java Virtual Machine (JVM) installed. The
most common JVMs are the Microsoft Virtual Machine and the Sun JVM.

Microsoft does not supply their Java VM in their new products and does
not allow it to be downloaded from their Website because of legal
problems with Sun Microsystems. Hence it is preferable to use the Sun
JVM.

To download the Sun JVM, point your browser at http://java.sun.com
and click on the Download Java link. This will install the Java Runtime
Environment as well as the Java plug-in. The latest version as of this
printing is 1.4.2. To see the JVM version in Internet Explorer, go to
Tools menu and select Sun Java Console.
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For Microsoft Virtual Machine, the version should be 5.0.0.3802 or
above. To see the JVM version, go to View -> Java Console in Internet
Explorer. A window will open showing the Java Console. 

The first line shows the JVM version (“Microsoft (R) VM for Java, 5.0
Release 5.0.0.3810” in the screen above). If Java Console is not shown
in the View Menu, go to Tools -> Internet Options, select the
“Advanced” Tab, scroll down the list to Microsoft VM, or Java VM and
check the box titled “Java Console Enabled (requires Restart)”. You will
be asked to reboot the machine in order for the setting to take effect.
If an older JVM is used, you may not be able to control the CWM
elements by clicking on the icons.

An incompatible JVM version is one of the main causes of failure to
connect or login for CWM. If the loading of the web page is extremely
slow, try switching the JVM. We have found that the web page loads
faster using the SUN JVM in some Windows XP machines. To change
the Java VM in Internet Explorer browser, select the Tools Menu >
Internet Options > click the Advanced Tab. To select the Sun JVM,
check the “Java (Sun)” Box shown below. To use Microsoft JVM, clear
the Java (Sun) box.

5



Comfort Web Server Module

6



Comfort Web Server Module

Section 2Connecting up the CWM

Connections

1. Before connecting, set the ID on SW7 to the ID of the CWM
according to the table in the previous section and according to the
number of other UCMs in the Comfort Network. If there is only 1, set
the ID to 2. By convention, ID 1 is reserved for UCM01/02 to
upload/download from Comfort. Communications Failure is not
reported for ID=1. Up to 8 UCMs of different types (e.g. C-Bus, EIB)
can be connected to the Comfort network.

2. The CWM is connected to Comfort via the supplied 4 way white cable
from 4-pins header JP2/2A to Comfort’s header J15. It is not
necessary to switch off the power to Comfort before plugging in this
connection.

3. The Green RDY led on the UCM (D1) should light up and remain on.
The LEDs D9 (red) and D10 (green) should blink rapidly showing
that RS485 communications has been established between Comfort
and the UCM. D9 (green) flashing shows that it is receiving
communications from Comfort (poll). D10 (red) comes on when the
UCM responds to a poll from Comfort.

4. The following few pages illustrates how the CWM is to be connected
depending on the way that the CWM is to be linked to the internet,
i.e. whether it is via a dial-up modem, via a PC as a gateway on a
network, or whether it is through a router. Note that for all cases;
always connect the network cable to the CWM RJ45 socket before
connecting power to the CWM. If the CWM is powered on before the
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Network is connected, its network drivers will not be loaded and the
network connection will NOT work.

Dial Up Connection

Internet

CWM

Switch or Hub

Network CameraNotebook

Comfort

RS232 Cable

56K
Modem

Optional connection to LAN

PSTN
Telephone Line

The above figure shows how the connection is to be done when an
external modem is connected directly via the CWM serial port. The
incoming telephone line is still connected to the TEL-IN port of Comfort,
while the TEL-OUT is connected to the external modem as well as other
telephones within the premises. If such a non-dedicated line is used for
internet access, any alarm or event triggering a dial out will result in the
line being seized for dialing out purposes.

The CWM also has an Ethernet port with a RJ45 connector for connection
to a Local Area Network via a hub or switch. This allows any PC or laptop
on the LAN to be able to access the CWM.
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Broadband Internet via PC Gateway

In this configuration, an ADSL or cable modem is connected directly to a
PC. This gateway PC and CWM as well as other computers and devices
are connected to a hub or switch. In order for the devices on the network
to share the Internet connection, the gateway PC must run a software
router like Winroute Pro. The software router must be set up to allow
port forwarding to the CWM and network camera(s) which are to be
accessed from the Internet. The gateway must also run a DNS update
software to work with a dynamic DNS redirection service like no-ip.com.
This can also be done using Cytech’s Dynamic IP system (see “Dynamic
IP Setup”). The gateway must always be on to allow Internet access. It is
recommended that the gateway PC be a dedicated machine for this
function.
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Broadband Internet with Router

In this configuration, an ADSL or cable modem is used for Internet
connectivity and a router is used to allow the other computers and CWM
to share the Internet connection. The router must be set up for port
mapping or forwarding for the CWM and network cameras which are to
be accessed from the Internet. All the network devices are connected to
a switch or hub. In order to provide the dynamic IP address to the
remote browser, one of the PCs on the network must run DNS update
software to work with a dynamic DNS redirection service like no-ip.com
or run on Cytech’s Dynamic IP system (See “Dynamic IP Setup”).
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Section 3Setting up the CWM
This section shows how to configure the CWM to change the IP address
and specify how to connect to the Internet. 

Connecting CWM to the Network
In order to set up the CWM, it is necessary to connect a computer,
either Desktop or Notebook with a network card to the CWM on the
Local Area Network (LAN) using the TCP/IP protocol. This can be done
by connecting a crossover CAT5 cable directly between the computer
and CWM or by connecting the CWM to the network via a hub or switch
using a parallel CAT5 cable.

NOTE: Always connect the network cable to the CWM RJ45
socket before connecting power to the CWM. If the CWM is
powered on before the Network is connected, its network
drivers will not be loaded and the network connection will NOT
work

Setting up the CWM
The CWM is set by default to the IP address 10.0.0.16. Should the IP
address be amended and forgotten, proceed on to the section “Running
CwmSetup”. To set up the CWM, open up the web browser with the
following address:

http://10.0.0.16/admin.htm

Note that this address is only for the default IP address 10.0.0.16 with
Port 80. For other IP addresses, please access the admin page via the
format:

http://(IPaddress):(PortNumber)/admin.htm

This should bring up the following screen:
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Select “Module Setup” to continue, which will bring up the screen
shown in “Module Setup”.

Running CwmSetup
CwmSetup.exe is a Windows program which discovers the IP address
of the CWM and allows a new IP Address to be assigned. It also
launches the browser-based configuration program which sets up other
parameters like the Webserver port, Internet connection method, DNS
and gateway addresses, FTP addresses etc. CwmSetup.exe is supplied
in the CD-ROM which comes with CWM.

The CwmSetup program screen is shown below:
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The program identifies the MAC address and IP Address of the CWMs
on the local network. The button “Change IP Address” allows the
selected CWM IP address to be changed from the default 10.0.0.16.
Change the IP address so that it is on the same subnet as the
computer used to configure the CWM. For example, if your computer IP
address is 192.168.0.1 and the subnet mask is 255.255.255.0, then
the CWM can be set to any IP address from 192.168.0.2 (as not to clas
with computer’s IP) to 192.168.0.254 to be on the same subnet.

Click on “Configure” to continue to configure the CWM. This opens a
series of browser-based screens. The opening screen is 

“Welcome to CWM Configuration Wizard 

Click Next to continue”

Module Setup

Before clicking on Next, please ensure that Engineer Sign In option is
enabled. The next screen shown below will ask for the user name and
password to access the screen.

13
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Both the default user name and password is “admin”. The password
can be changed later

If the Engineer Sign In option has not been enabled, the following
screen will be loaded after signing in.
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With the correct login, the Local IP address and Net mask are
displayed, and can be changed if required depending on the network in
which the CWM is connected.

The Web server port is the port on the CWM for the web server. This is
usually port 80. However, CWM will work with port numbers other than
80, if port 80 is used for another Web server or other devices.

The Pass-through Port (default 10001) is another port on which the
UCM (Universal Communications Module) can be accessed via TCP/IP
over the network rather than by RS232, as with a regular UCM. This
can be used for remote upload and download with the Comfigurator
software tool. Comfort firmware Outside 4.200 and above and CWM
5.52 and above are required to support this feature.

Proxy can also be set from this page if needed.

Press next for the next screen when completed to show the following
screen;

15
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This allows you to select the method for Internet connection; either by
dial-up or through the LAN (Local Area Network). For dial-up
connection, an external modem (not supplied) is to be connected to the
serial port of the CWM. For LAN, the CWM is to be connected to the
LAN via the Ethernet port and will access the Internet through a
gateway (router or PC) on the network (as shown in the previous
section). Press Next to continue to the next screen. 

For LAN connection, the screens pertaining to Dial-up (Dial-up
Connection Parameters, Web Camera, and Web Camera Part 2) will not
appear. Refer to the screen titled LAN Configuration. If the CWM is not
meant to access the Internet, select LAN connection.

If a Dial-up connection was specified for Internet Connection, the next
screen is shown in the next figure. 
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Dialup Parameters

The ISP Phone number, user name, password, are to be entered in the
corresponding fields. The Idle Time-out in minutes is for disconnection
of the dial-up connection when there has been no activity for the
specified time. The parameters entered are stored in CWM.

Press Next to continue.

The above screen allows network cameras to be viewed through the
same Internet connection and IP address as the CWM. For dial-up
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modem configuration, the CWM performs Port Mapping to map ports on
the Internet IP address to a private IP address and Port on the local
network.

Up to 10 network cameras can be connected. Enter 0 if network
cameras are not used. The network cameras have a built in Webserver
e.g. Axis 2100. 

The web cam base port is the starting port number through which the
camera images will be accessed. CWM uses port mapping to map the
Internet IP address port number to a local IP address and port.

The above screen shows what is displayed when there are 2 network
cameras specified. For each camera, enter the local IP address and port
number to access its internal Webserver. Normally the port number will
be 80, the http port. 

For Internet Access via LAN, the dialogue for web cameras will not
appear. If the gateway is a PC, it will require a software router like
Winroute Pro to perform the NAT (Network Address Translation) and
Port Mapping to allow requests from the Internet to be routed to the
CWM and Network Cameras. This is explained in Section 7 - Gateway
Setup

The next screens described below (LAN Configuration and Renew
Period) pertain to LAN configuration. For Dial-up Internet access, the
LAN Configuration and Renew Period pages will not be shown; the FTP
Server page will appear next. If the CWM is to be accessed from the
Local network only and not to be connected to the Internet, skip the
LAN configuration and Renew screens and go to the FTP Server page.

For LAN connection the screen will be as shown in the following figure;
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LAN Setup

The above screen specifies the gateway IP address of a router or PC on
the network which provides Internet access. The Name Servers fields
are the servers on the Internet which provide the Domain Name
Service for the Internet connection. Refer to your Internet Service
Provider or FTP host for the IP addresses of these servers. Click on
“Next” to continue.

After setting the gateway IP, click on Finish to save the configuration.
Should any other amendments be required, use the Back button to go
back to any of the previous pages to make the necessary changes. To
quit without saving, click on Cancel.

19
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After saving the changes, click on reset on the screen to reset the
CWM. It will probably take a few minutes before the CWM is initialized.
A good way of verifying that the CWM is initialized is by running
CwmSetup and seeing whether it can be detected.

Dynamic IP Setup

Most Internet connections will have a dynamic IP address, i.e. the IP
address will be assigned by the Internet Service Provider (ISP) will
change from time to time. For a dial-up modem connection, a different
IP address is assigned each time the dial-up connection is made. For
ADSL, some plans include a fixed IP address, usually for companies
running their own web server. For plans which involve dynamic IP
address, the IP address may not change for some time, sometimes
every few days. Cable modem connections usually involve dynamic IP
addresses. To access CWM from a remote browser on the Internet, the
IP address of the system must be known. For fixed IP addresses, you
can just type in the IP address or URL (and optionally port number if
not 80). For dynamic IP addresses, there are 3 methods of getting the
dynamic IP address of the CWM; using Cytech Technology’s Dynamic IP
redirection system, using FTP to send the current IP address to your
own web page or using a dynamic DNS redirection service like
www.no-ip.com. Use of other Dynamic IP Redirection services is not
within the scope of this manual.

Ensure that the Engineer Sign In Option is enabled (by pressing F0 on
the keypad). If the CWM has been reset, the Engineer Sign In Option
has to be enabled again to broadcast to the CWM. 

To configure Dynamic IP setup, go to the CWM setup page, i.e.

http://(IPaddress):(PortNumber)/admin.htm

and select Dynamic IP Setup.

20
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The Renew Period gives the time interval for CWM to refresh the
dynamic IP address for the connection to the remote web page.

In order to use Cytech’s IP redirection system, check the box in the
above screen

Cytech’s dynamic IP redirection service is hosted on the company’s web
server. The user registers with a username and password on the setup
screen. CWM will send its IP address periodically to the allocated space
on the website. To access the CWM from any browser on the internet
point your browser to the URL 

http://www.cytech.biz/dynip/username.php 

where “username” is the user name which is entered in the Dynamic IP
setup page. The browser will be redirected to the actual IP address of
the CWM. Note that the Cytech web site does not host the users CWM
pages or gather any information about the CWM other than its IP
address. However it must be noted that anyone who enters the same
URL will be redirected to the CWM at the IP address. Anyone who has
inadvertently or deliberately reached the CWM IP address must know
the User code of the Comfort system in order to sign in. If there are 6
attempts to sign in on the CWM web page, keypad or telephone, the
Sign In Tamper Alarm will be activated which will lock out further
attempts.

21



Comfort Web Server Module

For those using Cytech’s dynamic IP system, all that is needed is for
the user to register with a user name and password. The email address
field is not used – it does not have to be entered. The link to the CWM
will be set as http://www.cytech.biz/dynip/(UserName).php. 

For those not using Cytech’s dynamic IP redirection system, do not
check the box in the previous screen. In this case, the user will have to
specify an FTP address to which the CWM can upload the IP address.
This also allows a URL address e.g. www.userpage.com/home.html set
up by the user, to host the IP address redirection, without relying on
Cytech’s web server.

The FTP Server screen will ask for the address of the FTP server, as
well as the user name and password for logging in. All these
information are normally obtainable from the provider of the web
space.

The FTP server directory is the path within the FTP server to send the
dynamic IP address. This is often “public_html” or “/”. This information
should be available from your ISP or your FTP host.
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Press Next to continue

Click Finish to save the configuration. 

This shows that the configuration has been saved. Press the Reset link
on the screen to reboot CWM. It is not necessary to switch the power
off and on as in previous versions. 

Upgrading the CWM Software

To help facilitate the updating of the CWM, an online updating
mechanism has been set up. To upgrade the CWM, please ensure that
you are online. Then, simply click on the link in

23



Comfort Web Server Module

http://(IPaddress):(PortNumber)/admin.htm and the CWM should be
updated accordingly.

Changing Password

Here, the Engineer Sign In Option has to be enabled again. You may
need to do so again if the CWM has been reset. Selecting this option
allows the Password to be changed. This will replace the existing
password. However, note that the user name will still be maintained as
“admin”.

Testing CWM on the Local Network

Once you have done the setup as described above, you can test CWM
immediately without needing to do any programming of CWM. Make
sure Comfort is powered on and connected to the CWM via the supplied
4 way cable. Comfort can be programmed to the default template.
Remember that minimum “Outside” firmware on U1 is required.

CWM can be connected to the PC with the supplied crossover Ethernet
cable, or it may be connected to the Local Area Network (on the same
subnet) via a hub.

Open your browser (Internet Explorer 5 or 6, or Netscape 7, Opera 7 or
other Java-enabled browser) on the computer which you have used to
set up the CWM, or any computer on the network to which you have
connected the CWM (with the same subnet).

Type in the local IP address of CWM, e.g. 10.0.0.16 or the IP address
was assigned during the setup procedure.

24
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The browser will display “Loading in progress.” During this time, the
Java Virtual Machine is loading on your computer. After 10 to 30
seconds, depending on the speed of your machine, the Login window
will appear, which prompts “Please Sign In”

Enter your Comfort sign in code which can be from 4 to 6 digits. Any
valid Comfort user code will allow access. These codes are kept within
Comfort, not the CWM or on any web site so there is better security. It
is recommended that sign-in codes be 6 digits for maximum security.

Once the user code has been validated, the default web page will be
displayed, as in the example below with the sample index.htm file.
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When the page loads, the state of the outputs 1 to 8 and inputs 1 to 8
will be updated, displaying the images for the object depending on
whether the object is on or off. Please ensure that the message window
indicates “All images are up-to-date”.

When any programmed zone is activated the corresponding image will
change from white to blue (if nothing happens, it probably means that
the one has not been programmed).

Clicking on any output will cause the state to change, from off to on, or
on to off. When the cursor is over the icons, the cursor will change to a
finger, and the border of image will be highlighted. Clicking on the
image will cause the familiar hourglass to appear until the cursor is
moved away from the image. An “acknowledge’ announcement is heard
when the user clicks on the image (provided a sound card is installed).
To get the best results, keep the left mouse button pressed for a
second or so when clicking on an image. Short clicks tend to get
missed out.
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The bottom row of icons is for arming and disarming. 

Security Off Away Mode Night Mode Day Mode
Vacation

Mode

Arm Comfort by clicking on the Away, Day, Night, or Vacation icons. As
this is a security operation, the Sign-in box will appear on screen. Enter
your user code to enable the operation. If the code is authorized, the
system will be armed after the programmed exit delays. The Security
Mode icon in the 3rd row will change to the corresponding icon, which
is an animated gif. To disarm, click on the Home icon. Comfort will be
disarmed to Security off when the user code is entered, and the
Security Mode icon will change to Home.

The Alarm State icon shows Good, Trouble, Alert or Alarm.

The Text window displays Status messages from Comfort.

If the CWM dial-up and remote FTP settings have been correctly
programmed, then it would also be possible to access the system from
the Internet.

Accessing the CWM via Cytech’s Dynamic IP System

For those who are not accessing via the local network, and are using
Cytech’s dynamic IP system, you can access the CWM via
http://www.cytech.biz/dynip/(UserName).php. There, the following
login screen will be loaded.

The password is the password set by the user in the dynamic IP setup
as explained earlier in this section. Simply login with the correct
password. This will then load the next screen:

This screen serves to show the current address of the CWM, as well as
the last address update. The page should be re-directed to the current
CWM address. If it does not seem to be redirecting, the user may also
click on the link on the page.

After that, the steps will be similar to that of connecting to the CWM on
the local network, i.e. signing in with Comfort’s sign-in code, etc.
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Accessing the CWM via Other DNS Systems

For those who are accessing the CWM by other means besides using
Cytech’s dynamic IP system, you will normally have a webpage which
will redirect the user to the relevant webpage, e.g. a web page with a
link as shown below.

In such a case, the user will also be redirected to the current updated
CWM address. There, the steps to login are similar to the other 2
methods.

28



Comfort Web Server Module

Section 4Programming

Uploading Files to CWM

Previously, to upload files to the CWM, File Manager had to be used.
However, this is tedious in nature as it only allows for the uploading
and downloading of 1 file at a time. To speed up these processes, with
this current version (5.70), File Manager has been removed. File
uploads and downloads can easily be done with the help of FTP. 

FTP via Browser

CWM now currently supports FTP. For Windows 2000 and Windows XP,
it can be accessed using the following address by keying in the
following address in Internet Explorer (or any compatible browsers):

ftp://(IPaddress)

For example, for the default CWM configuration, one can upload files to
the CWM from ftp://10.0.0.16/

To login, engineer menu must be enabled. Then, access the address
format as shown above. If you encounter an error message, click on
“OK” to clear the message. After that, right click on the screen and
select “login as”. Then, login as username “admin” with the correct
password. The default password is “admin” unless amended (See
“Changing Password”). Following that, the following screen should
appear:

From this screen, uploading of files to the CWM is simpler. Simply copy
and paste the files that you wish to upload to the CWM to this page and
to whichever directory one wants. Directories can also be created.
Similarly, it also allows for the downloading of files from the CWM. This
greatly enhances the ease of troubleshooting when the need arises.
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FTP via FTP Client

For those who are using Windows 98 have to use a FTP client like WS
FTP and will have to configure it to connect to the CWM.

The above screen shot is an example of using WS FTP. Note that it has
been configured to work with a CWM of address 10.0.0.21. The User ID
and passwords need to be set as well. Correctly entering the username
and password, you should be able to connect to the CWM FTP server as
shown below.
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TCP/IP Pass-through Port

TCP Pass-through is a function whereby the Ethernet data is directly
passed to the RS232 port of the UCM within the CWM and vice versa.
This allows serial commands to be sent and status received using the
LAN or Internet. It allows Comfigurator or WizComfort to work through
the CWM by specifying a Network IP address and Port.

In order to enable the Pass-through port operation, Engineer Code
must be enabled, by pressing F0 on the Keypad as usual. If Engineer
Code is disabled at midnight on the same day or in Program Menu
3,4,0, the Pass-through Port will also be disabled. Only 1 Pass-through
port can be established at one time.

While pass-through port operation is in progress, applet
communications will cease, i.e. the normal operation of the CWM will
stop. You will not be able to control or monitor Comfort via CWM until
the pass-through connection is closed by disabling Engineer Code using
Program Menu 3,4,0 or using the shortcut key “F+0” (unless it has
been amended).

The default pass-through port number is 10001. This is specified in the
browser setup using cwmsetup.exe or under the Module Setup page in
http://(IPaddress):(PortNumber)/admin.htm. Port numbers can range
from 0 to 65535. The official list can be found at
http://www.iana.org/assignments/port-numbers

Port numbers already used by CWM are 20 (file transfer data), 21 (file
transfer control), 23 (telnet), 80 (http), 8080 (http alternate) and
10001 (default pass-through).

The Pass-through port feature is enabled on CWM firmware 5.63 and
above.

If installed in a system with a firewall, check that the firewall
does not block the assigned port for TCP/IP pass-through.
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Web Page Programming

The Comfort Web Server Module (CWM) enables Comfort to be
controlled and monitored from a standard web browser such as
Microsoft Internet Explorer and Netscape Navigator. The CWM makes
use of Java Applets to provide icons and switches which change with
the state of the device being monitored. These Java Applets interact
with control variables which exchange information between the client
browser and the server. The Java Applets are provided in webcom.jar,
which contains Applets for controlling or monitoring input and output
devices, X10, security mode, camera and alarm state. The applet code
can be embedded in the HTML file using the <APPLET> tag.

The Java Applets are designed to send commands to Comfort by means
of programmed Responses. The Responses must be preprogrammed in
Comfort to perform the desired operations. Any Response can be
activated by means of the Applets. For example, if Response 1 turns on
Output 1, clicking on an icon can be programmed via the applet to send
Response 1 to Comfort via the CWM.

The Java Applets monitor the state of variable like Zone, Output, X10,
the Security Mode, and Alarm state, and can display the changed state
using a specified image. 

For each alarm input or appliance monitored or controlled by Comfort,
two images are associated; one when it is On, and one when it is Off.

For example, the radio when it is off is shown as  When it is

turned on, it can be represented as , The program line which
controls this element is illustrated as an example.

<PARAM NAME=”Element1” VALUE=”zone, 2, 5, /comfort/radio1.gif, 6,
/comfort/radio0.gif, 350, 20, 1”>.

This means the ON/Off status of the radio is monitored by Zone 2. If
Zone is Off, radio0.gif is displayed, and zone 2 is On, radio1.gif is
displayed.

Clicking on the radio icon will change its state, i.e. if it is On, it will turn
off and vice versa. The programming line shown above specifies that
Response 5 is used to turn on and Response 6 is used to turn off the
radio. The set of coordinates tells where the icon should be located on
the page.

Note that because of the visual feedback of the appliance state offered
by web-based access, it is very desirable to monitor the state of the
appliance. This can be done using a CSM01 current sensor connected
to a zone input for many appliances.
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Programming Elements
A sample index.htm page would look like this:

<HTML>
<HEAD>
<TITLE> ........ </TITLE>
</HEAD>
<BODY>
<APPLET CODE=WebComfort.class ARCHIVE=webcom.jar, cvp.jar
WIDTH=700 HEIGHT=500>

The above line specifies the Java archive to be downloaded to the
browser.

The definition of the elements on the Java Applets follows. These
consist of a series of statements of the form;

<PARAM NAME= ”name” VALUE=”value”>

...

...

</APPLET>

</BODY>

</HTML>

The types of elements used are; Element, Window, Mode, Arm,
Cam, State, Counter, Cntr, RespIcon, IconHighlight. Each
parameter is assigned a sequential numeric value starting with 1 for
each of the types, for example, 

<PARAM NAME=”Element1” VALUE="zone,4,0, /comfort/md1.gif,0 ,
/comfort/md0.gif, 19,376,1">

<PARAM NAME=”Element2” VALUE="zone,5,0, /comfort/detect1.gif,0 ,
comfort/detect0.gif , 120,278,1">

A break in the sequence numbering for each element will invalidate the
rest of the sequence. The element of each type need not be
contiguous, i.e. they may be followed by other elements, but the
sequence number of the element must be maintained, e.g., the
following sequence is acceptable:

<PARAM NAME=”Element1” VALUE="......">

<PARAM NAME=”Arm1“ VALUE=”.......">

<PARAM NAME=”Element2” VALUE=".........">

<PARAM NAME=”Element3” VALUE=".........">

<PARAM NAME=”Arm2“ VALUE=”.......">

The following sequence is NOT acceptable because of a break in the
sequence:

<PARAM NAME=”Element1” VALUE="......">

<PARAM NAME=”Arm1“ VALUE=”.......">
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<PARAM NAME=”Element3” VALUE="........."> (ELEMENT2 is
missing!)

For each type, a token string is required in the “VALUE=” field. The
number of tokens and the format of the tokens must be strictly
adhered to.

The image files are normally stored in a subdirectory. In the examples
shown, they are in the “/comfort” subdirectory

The types of parameters are defined below:

Window

Format: 

<PARAM NAME=”Window#” VALUE="Title, window-image">

Explanation:

The parameter “Window” creates a new window on the screen. The
first token is the title which will appear on the title bar. The second
token is the name of the image file which will be displayed in the
background. This image file may be in .gif or .jpg format which are the
ones accepted by Java. The size of the window is determined by the
image file. Keep the image size within the limits of your display. A
minimum display resolution setting of 800 x 600 for pixels is
recommended for the monitor.

The image file should consist of the static or fixed layout of the
premises to be monitored on CWM. Any painting program line Windows
Paint, or Paint Shop, or a Floor Plan design software can be used to
create the background image.

Up to 8 windows may be used to represent different levels in a
home or building.

Example:

<PARAM NAME=”Window1” VALUE="Office,
/comfort/office.gif">

This opens a window titled “Office” with a background image using
office.gif.

Element (zone and output)

Format: 

<PARAM NAME=”Element#”   VALUE=”zone, number,
response_on, on-image, response_off, off-image, x,y, window ”>

<PARAM NAME=”Element#”   VALUE=”output, number,
response_on, on-image, response_off, off-image, x,y, window ”>

Explanation:

The element name “Element” is used to represent devices like lights
and appliances which are controlled by Comfort, as well as devices
which are connected to Comfort Zone Inputs. The state of the device,
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either off or on is represented by alternate images. The device state
can be provided by a Zone (Input) or Output number.

“zone” is the token which indicates that a zone (input) is providing
the status feedback for the device.

“output” is the token which indicates that an output is providing the
status feedback for the device.

“number” is the zone (Input) or Output Number (0 to 64) on
Comfort which provides the status feedback for the device to Comfort.
If “zone” is specified, the zone number must be programmed to the
appropriate zone type. An unprogrammed zone will not respond. If
"zone" or "output" is 0, this means that there is no feedback status,
and only the Off Image will be displayed. Clicking on the image will
alternately activate the response_on and response_off.

“response_on” is the Comfort Response (program) number (1 to
254 for Outside; 1 to 1023 for Action) which turns on the device. The
Response number specified must be programmed to perform the
required actions. (This is not to be confused with the Zone On
Response which is activated when the zone goes on)

“On-image” is the image file which represents the device when it is
in the ON state. Note that the definition of Off and On depends on
whether the Zone Type used is Normally Open or Normally Closed.

“response_off” is the Comfort Response (program) number (1 to
254 for Outside; 1 to 1023 for Action) which turns off the device. The
Response number specified must be programmed to perform the
required actions. (This is not to be confused with the Zone Off
Response which is activated when the zone goes on).

“Off-image” is the image file which represents the device when it is
in the OFF state. Note that the definition of Off and On depends on
whether the Zone Type used is Normally Open or Normally Closed.

“x” and “y” are the x and y coordinates of the image displayed.
Coordinates are referenced from the top left corner of the window and
the size extends from the top left corner of the image to the right and
downwards.

“Window” is the window number which the element belongs to.

Example:

<PARAM NAME=”Element1”   VALUE=”zone, 2, 17,
/comfort/lightcir_1.gif, 18, /comfort/lightcir_0.gif, 350, 20, 1”>

This element represents a light controlled by Comfort and whose
status is fed back to Zone (Input) 2 via a Current sensor (CSM01).
lightcir_1.gif is the image shown when the light is on (Input 2 on) and
lightcir_0.gif is the image shown when the light is off (Input 2 off).
Clicking on the light switches will turn off or on the light depending on
its current state. Response 17 turns on the light and Response 18 turns
off the light. The image is at coordinates (350,20) in Window number
1.
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The “zone” element allows control of any device using Responses
which can be programmed for infrared control, x10 transmission, pulse
outputs or on/off control and where the device state is available on an
input zone through a current sensor.

<PARAM NAME=”Element2”   VALUE=”output, 5, 9,
/comfort/lightcir_1.gif, 10, /comfort/lightcir_0gif, 420, 50, 2 ”>

This element represents a light controlled by Comfort and whose
status is in output 5. Lightcir_1.gif is the image shown when the light is
on (output 5 on) and lightcir_0.gif is the image shown when the light is
off (Output 5 off). Clicking on the light switches off or on the light
depending on its current state. Response 9 turns on the light and
Response 10 turns off the light. The image is at coordinates (420,50) in
Window number 2.

The “output” element can be used for devices which are controlled
directly through the outputs without any input feedback. For example a
pulse to open a gate or door will show the on image momentarily
during the duration of the pulse. A device which is controlled directly
from the outputs is also represented in this way.

<PARAM NAME=”Element3”   VALUE=”zone, 15, 0,
/comfort/detector1.gif, 0,  /comfort/detector0.gif, 550, 10, 1 ”>

This element represents a motion detector connected to Zone
(Input) 15. detector1.gif is the image shown when the detector detects
movement (Input 15 on) and detector0.gif is the image shown when
the detector is off (Input 15 off). In this case the response_on and
response_off is 0, i.e. not used because this element provides status
only and not control.

A zone or output number of 0 is valid and means that there is no
feedback for this element. This is used to issue a command without
feedback status. The off-image file will be displayed at all times, as an
on status will not be received. A valid filename must be specified for
the on-image even though it is not used. 

e.g. <PARAM NAME=”Element3”  VALUE=”zone, 0, 16,
/comfort/imageoff.gif, 16,  /comfort/imageoff.gif, 550, 10, 1 ”>

This displays imageoff.gif at all times. When clicked, Response 16 is
always activated. If the on and off responses specified are different,
then they will be alternately activated

This method is used to implement the Disconnect function to cause
the dial-up modem to hang up. This is described in more detail in the
“Programming Comfort” section.

Element (X10)

Format: 

<PARAM NAME=”Element#” VALUE=”x10, housecode, unitcode,
response_on, on-image, response_off, off-image, yes/no, x,y, window
”>
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Explanation:

The token “x10” for parameter “Element” is used to represent the
status of X10 modules. X10 commands to the addresses from wall
switches or other x10 controllers will be reflected in the image
displayed. 

“X10” is the token name for x10 control

“Housecode” is the housecode (A to P) of the x10 module to be
controlled and monitored.

“Unitcode” is the unit code (1 to 16) of the x10 module to be
controlled and monitored.

“response_on” is the Comfort Response (program) number (1 to
254 for PRO, 1 to 1023 for ULTRA) which turns on the x10 module. The
Response number specified must be programmed to perform the
required actions. 

“On-image” is the image file which represents the device when it is
in the ON state. 

“response_off” is the Comfort Response (program) number (1 to
254) which turns off the device. The Response number specified must
be programmed to perform the required actions. 

“Off-image” is the image file which represents the device when it is
in the OFF state. 

“Yes” or “no” indicates if the x10 module is a lamp module which
can respond to the All Lights On and All Lights Off x10 commands.
Please check with the X10 module instruction sheet to find out whether
the module does respond to these commands.

“x” and “y” are the x and y coordinates of the image displayed.
Coordinates are referenced from the top left corner of the window and
the size extends from the top left corner of the image to the right and
downwards.

“Window” is the window number which the element belongs to.

Example:

<PARAM NAME=”Element4”   VALUE=”x10, A, 1, 33,
/comfort/moduleon.gif, 34,  /comfort/moduleoff.gif, no, 350, 20, 1”>

This element represents an X10 module with x10 address A1
(housecode=A, unitcode=1). moduleon.gif is shown when the module
is on and moduleoff.gif is shown when the module is off. Clicking on
the device icon switches off or on the module depending on its current
state. Response 33 turns on the light and Response 34 turns off the
module. The image is at coordinates (350,20) in Window number 1.
“No” indicates the module is not a lamp module which can be controlled
by the “All Lights On” X-10 command.

Note:
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When the window is first opened, the X-10 elements are shown in
the off state, as X-10 modules cannot be polled for their current state.
The state is updated when the module is controlled for the first time.

Arm

Format: 

<PARAM NAME=”Arm#”   VALUE=”off-x, off-y, off-image,
away-x, away-y, away-image, night-x, night-y, night-image, day-x,
day-y, day-image, vac-x, vac-y, vac-image, window ”>

Explanation:

This parameter allows the system to be disarmed (security Off) or
armed to Away, Night, Day and Vacation modes. This parameter does
not show the security mode - display of the current security is by
parameter “mode”.

“Off-x, off-y” are the coordinates of the security off image.
Coordinates are referenced from the top left corner of the window and
the size extends from the top left corner of the image to the right and
downwards.

“off-image” is the image file for security off

“Away-x, away-y” are the coordinates of the away mode image.
Coordinates are referenced from the top left corner of the window and
the size extends from the top left corner of the image to the right and
downwards.

“away-image” is the image file for away mode

“Night-x, night-y” are the coordinates of the night mode image.
Coordinates are referenced from the top left corner of the window and
the size extends from the top left corner of the image to the right and
downwards.

“night-image” is the image file for night mode

“Day-x, day-y” are the coordinates of the day mode image.
Coordinates are referenced from the top left corner of the window and
the size extends from the top left corner of the image to the right and
downwards.

“day-image” is the image file for day mode

“Vac-x, vac-y” are the coordinates of the vacation mode image.
Coordinates are referenced from the top left corner of the window and
the size extends from the top left corner of the image to the right and
downwards.

“vac-image” is the image file for vacation mode

“Window” is the window number which this parameter belongs to.
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Example:

<PARAM NAME=”Arm1” VALUE=”0, 200,
/comfort/disarm.gif, 50, 200, /comfort/away.gif, 100, 200, /comfort/
night.gif, 150, 200, /comfort/day.gif, 200, 200, /comfort/vacation.gif,
1">

This places the disarm.gif image at (0,200), away.gif image at
(50,200), night.gif at (100,200), day.gif at (150,200) and vacation.gif
at (200,200). These elements are in window 1.

Mode

Format: 

<PARAM NAME=”Mode#” VALUE=”x, y, off-image, away-
image, night-image, day-image, vac-image, window”>

Explanation:

This parameter displays the current security mode (off, away, night,
day, Vacation) by specifying the image files in the parameter list. 

“x, y” is the location of the image to be displayed. Coordinates are
referenced from the top left corner of the window and the size extends
from the top left corner of the image to the right and downwards.

“off-image” is the image file for security off

“away-image” is the image file for away mode

“night-image” is the image file for night mode

“day-image” is the image file for day mode

“vac-image” is the image file for vacation mode

“Window” is the window number which this parameter belongs to.

Only one of the images is displayed in the same location, depending
on the current mode, so the images must be of the same size.

Note that this “Mode” parameter only displays the current mode,
while the “Arm” parameter controls the security mode.

Example:

<PARAM NAME=”Mode1” VALUE="150, 430,
/comfort/disarm.gif, /comfort/away.gif, /comfort/ night.gif,
/comfort/day.gif, /comfort/vacation.gif, 1">

This places the image at (150,430) and the selected image file will
be displayed depending on the security mode.

State

Format: 

<PARAM NAME=”State#” VALUE="x, y, base-image, idle-
image, trouble-image, alert-image, alarm-image, window">
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Explanation:

This parameter displays the current Alarm State of the system.
There are 4 states: Idle (No alarm), Trouble (e.g. zone trouble, power
failure, telephone cut etc.), Alert (Zone Alert, Entry Alert), and Alarm
(Intruder, Fire Panic). The image associated with each of these states
will be displayed when the system is in the corresponding alarm state,
and the image will blink. The “base” image is displayed during the
blink.

“x y” is the location of the image to be displayed. Coordinates are
referenced from the top left corner of the window and the size extends
from the top left corner of the image to the right and downwards.

“base-image” is the image file for base image which is displayed
during the blink

“idle-image” is the image file for idle state

“trouble-image” is the image file for trouble state

“alert-image” is the image file for alert state

“alarm-image” is the image file for alarm state

“Window” is the window number which this parameter belongs to.

Only one of the images is displayed in the same location, depending
on the current alarm state, so the images must be of the same size.

Example:

<PARAM NAME=”State1” VALUE="300, 430,
/comfort/base.gif, /comfort/idle.gif, /comfort/trouble.gif,
/comfort/alert.gif, /comfort/ alarm.gif, 1">

This places the image at (300,430) and the selected image file will
be displayed depending on the alarm state.

Cam

Format: 

<PARAM NAME=”Cam#” VALUE="x, y, webcam-image, ip-
address, destination-port, subnet-mask, source-port,window">

Explanation:

This parameter is used to place a camera icon on the web page and
allow the user to view the images on the camera. Only a network
camera with its own web server may be used, i.e. one that has an
Ethernet port with a built-in web server, like Axis and Samsung
Webthru. These products have models which act as camera servers
which allow several normal CCTV cameras to be connected. The
camera server is connected to the same local area network as the CWM
and must belong to the same subnet according to the subnet mask.

“x y” is the location of the image to be displayed. Coordinates are
referenced from the top left corner of the window and the size extends
from the top left corner of the image to the right and downwards.
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“webcam-image” is the image file for the camera.

“ip-address” is the local IP address of the camera.

“destination-port” is the port number of the camera web server,
usually 80.

“subnet-mask” is the subnet mask for the local network e.g.
255.255.255.0. 

“Source-port” is the port number of the camera web server when
accessed from the Internet. CWM is able to do “port forwarding” from
the Internet. As there will only be one public IP address assigned when
it is connected to the Internet, access to the camera will use the same
public IP address with a port name. Port forwarding translates the IP
address:port address to a local IP address and allows several local IP
addresses to be accessed using a single public IP address. The port
numbers should be what was specified in the setup procedure.

“Window#” is the window number which this parameter belongs to.

The camera server must be configured according to the instructions
of the product used, i.e. to set the IP address and subnet mask and the
viewing parameters.

For Video Servers where more than 1 CCTV camera can be
connected, there will be a single IP address to access the server. This
has to be set up like a single camera. The access will be to the server’s
home page where you can select the camera image to view.

Counter

Format: 

<PARAM NAME=”Counter#” VALUE="x, y, number, divisor, Q/R,
start-image, value1, value1-image, value2, value2-image,.., valueN,
valueN-image, window #">

Explanation:

The Counter element is used for C-Bus, EIB Instabus, and
Honeywell Smartfit interfacing where monitoring is by means of
counters. In C-Bus and EIB systems, the counters store the current
state of Group Addresses. 

“x y” is the location of the image to be displayed. Coordinates are
referenced from the top left corner of the window and the size extends
from the top left corner of the image to the right and downwards.

“number” is the counter number which is being monitored. The
allowable values range from 0 to 127 for PRO, and 0 to 255 for ULTRA.

“Divisor” is the value that is divided into the counter value to obtain
the value for comparison. The value for this parameter is expressed in
decimal. If the range of values desired is 0 to 100, then the required
divisor value is 2.55 (255/100). 

“Q” or “R” indicates if the values of interest to be displayed is the
Quotient or Remainder of the result. “Remainder” is used for displaying
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exact values like temperature. “Quotient” is used to display decimal
digits (hundreds, tens or single-digit values)

“start-image” is the image file which is displayed during upon
starting of Java or the lowest value image.

“value1” is the threshold value above which “value1-image” will be
displayed. In other words if the computed value is greater than or
equal to “value1”, the “value1-image” is displayed. 

“valueN” is the threshold value above which “valueN-image” will be
displayed. In other words if the computed value is greater than or
equal to “valueN”, the “valueN-image” is displayed.

“Window#” is the window number which this parameter belongs to.

Note: The threshold value must be in ascending order for the
system to work correctly.

Example 1:

Display counter 50 value (from 0 to 255) at Location (10,20) in 3
digits with each digit having a size of 30 x 30 pixels

<PARAM NAME=”Counter1” VALUE="10, 20, 50, 100, Q,
/comfort/0.gif, 1, /comfort/1.gif, 2, /comfort/2.gif, 1”>

This displays the hundreds digit (0,1,2)

<PARAM NAME=”Counter2” VALUE="40, 20, 50, 100, R,
/comfort/0.gif, 10, /comfort/1.gif, 20, /comfort/2.gif, 30,
/comfort/3.gif, 40, /comfort/4.gif, 50, /comfort/5.gif, 60,
/comfort/6.gif, 70, /comfort/7.gif, 80, /comfort/8.gif, 90,
/comfort/9.gif, 1”>

This displays the tens digit (0 to 9)

<PARAM NAME=”Counter3” VALUE="70, 20, 50, 10, R,
/comfort/0.gif, 1, /comfort/1.gif, 2, /comfort/2.gif, 3, /comfort/3.gif, 4,
/comfort/4.gif, 5, /comfort/5.gif, 6, /comfort/6.gif, 7, /comfort/7.gif, 8,
/comfort/8.gif, 9, /comfort/9.gif, 1”>

This displays the ones digit (0 to 9)

Example 2:

Display counter 255 value (0 to 255) in the range 0 to 100 as 3
digits as in example 1

<PARAM NAME=”Counter1” VALUE="10, 20, 50, 255, Q,
/comfort/0.gif, 1, /comfort/1.gif, 1”>

This displays the hundreds digit (0,1)

<PARAM NAME=”Counter2” VALUE="40, 20, 255, 25.5, Q,
/comfort/0.gif, 1, /comfort/1.gif, 2, /comfort/2.gif, 3, /comfort/3.gif, 4,
/comfort/4.gif, 5, /comfort/5.gif, 6, /comfort/6.gif, 7, /comfort/7.gif, 8,
/comfort/8.gif, 9, /comfort/9.gif, 10, /comfort/0.gif, 1”>

This displays the tens digit (0 to 9)

If the additional threshold value of 10 is omitted it will display 190
instead of 100 when the maximum value of 255 is received.
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<PARAM NAME=”Counter3” VALUE="70, 20, 50, 25.5, R,
/comfort/0.gif, 2.55, /comfort/1.gif, 5.1, /comfort/2.gif, 7.65,
/comfort/3.gif, 10.2, /comfort/4.gif, 12.75, /comfort/5.gif, 15.3,
/comfort/6.gif, 17.85, /comfort/7.gif, 20.4, /comfort/8.gif, 22.95,
/comfort/9.gif, 1”>

This displays the ones digit (0 to 9)

Example 3:

This example displays the counter value by means of a pointer to a
scale or water level in a tank. In this example there are 10 threshold
values.

<PARAM NAME=”Counter1” VALUE="100, 200, 255, 1, Q,
/comfort/0per.gif, 25.5, /comfort/10per.gif, 51, /comfort/20per.gif,
76.5, /comfort/30per.gif, 102, /comfort/40per.gif, 127.5,
/comfort/50per.gif, 153, /comfort/60per.gif, 178.5, /comfort/70per.gif,
204, /comfort/80per.gif, 229.5, /comfort/90per.gif, 255,
/comfort/100per.gif, 1”>

Cntr

Format: 

<PARAM NAME=”Cntr#” VALUE="x, y, number, on-
response, off-response, divisor, Q/R, start-image, value1, value1-
image, value2, value2-image,.., valueN, valueN-image, window #">

Explanation:

This is very similar to the Counter parameter except that clicking on
the image can activate on and off responses. When the image is
clicked, the value of the counter will be checked. The On-response is
activated if the counter has 0 value and the off-response is activated if
the counter has a nonzero value.

The Cntr element is used for C-Bus, EIB Instabus, and Honeywell
Smartfit interfacing where monitoring is by means of counters. In C-
Bus and EIB systems, the counters store the current state of Group
Addresses. Cntr is available from webcom.jar version 1.0.9 onwards.

“x y” is the location of the image to be displayed. Coordinates are
referenced from the top left corner of the window and the size extends
from the top left corner of the image to the right and downwards.

“number” is the counter number which is being monitored. The
allowable values range from 0 to 255.

“On-response” is the response that will be activated when the image
is clicked when the counter has a zero value (meaning that the device
monitored is off).

“Off-response” is the response that will be activated when the image
is clicked when the counter has a nonzero (1 to 255) value, (meaning
that the device monitored is on).
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“Divisor” is the value that is divided into the counter value. The
value for this parameter is expressed in decimal. If the range of values
desired is 0 to 100, then the required divisor value is 2.55 (255/100). 

“Q” or “R” indicates if the values of interest to be displayed is the
Quotient or Remainder of the result. Remainder is used for displaying
exact values like temperature. In most cases “Q” is used.

“start-image” is the image file which is displayed during upon
starting of Java or the lowest value image.

“value1” is the threshold value above which “value1-image” will be
displayed. In other words if the computed value is greater than or
equal to “value1”, the “value1-image” is displayed. 

“valueN” is the threshold value above which “valueN-image” will be
displayed. In other words if the computed value is greater than or
equal to “valueN”, the “valueN-image” is displayed.

“Window#” is the window number which this parameter belongs to.

Note: The threshold value must be in ascending order for the
system to work correctly.

Example 1:

Counter 100 value (0 to 255) at Location (10,20) represents a
Group address on EIB or C-Bus. A value of 0 indicates that the group
address is Off, while 255 means the Group Address is fully On. A value
between 1 and 254 indicates that the device (normally a light) is
dimmed at an intermediate level. This line will display different images
depending on the dimming level at the group address divided into the
ranges 25%, 50%, 75%, 100%.

<PARAM NAME=”Cntr1” VALUE="10, 20, 100, 201,202, 1,
Q, /comfort/off.gif, 64,/comfort/25pc.gif, 128, /comfort/50pc.gif, 192,
/comfort/75pc.gif, 255, /comfort/on.gif, 1”>

In this example, 10,20 is the coordinates of the image, 100 is the
counter number, 201 is the Response which is activated when the
counter value is 0, 202 is the Response which is activated when the
counter value is nonzero, 1 is the divisor (no division), Q means
Quotient is used for comparison, off.gif is the off level image, 64 is the
threshold value for displaying the next parameter 25pc.gif, 128 is the
threshold for displaying the next parameter 50pc.gif, 192 is the
threshold for displaying the next image 75pc.gif, and 255 is the
threshold for displaying the last image on.gif.

RespIcon

Format: 

<PARAM NAME=”RespIcon#” VALUE="type, x, y, image, window
#, action, action,...,action">
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Explanation:

This element is used to directly execute Actions via CWM as distinct
from Comfort Responses which reside in the Comfort Panel U4 IC. This
may be used when Comfort’s 255 Responses is not enough for the
application. Be careful when using this parameter so as not to conflict
with the Timers, Flags and counters which are already used by Comfort
Responses.

This parameter is available from webcom.jar 1.0.9 onwards

“Type” is for future use. It is ignored currently; please use a default
value of 1.

“x y” is the location of the image to be displayed. Coordinates are
referenced from the top left corner of the window and the size extends
from the top left corner of the image to the right and downwards.

“Image” is the image file which is displayed at the location specified.

“Window#” is the window number which this parameter belongs to.

“Action”,..,”action” is the list of actions to be executed. Each CWM
Response is made up of a maximum of 6 Actions. More than 1 CWM
Response can be executed in the same line by using “255” as a
separator. For example, act1, act2, act3, act4, act5, act6, 255, act7,
act8, act8, act10, act11, act12 will execute the first CWM response
consisting of act1 to act6, followed by the second CWM response
consisting of act7 to act12. Note that actions cannot start in a CWM
response and end in the next.

Example 1:

<PARAM NAME=”RespIcon1” VALUE="1, 10, 20, image1.gif, 1,
128,2,1,255, 195,65,1,5,”>

In the example, the Type is 1, location is (10,20), and window is 1.
The first CWM Action is 128, 2, 1 (Output 2 On), followed by the next
CWM Response 195,65,1,5 (X10 A1 On).

IconHighlight

Format: 

<PARAM NAME=”IconHighlight” VALUE="Off">

Explanation:

By default when you hover the mouse on any clickable image, the
rectangular border around the image becomes highlighted. This
parameter disables the highlighting feature. One of the instances where
you might use this is when multiple images are controlled by the same
action as in a bank of lights. If the highlight is enabled then placing the
mouse over one of the lights would cause a highlight over the whole
bank of lights which some may prefer not to see.
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Sample Program

This sample design monitors the state of 8 input zones, 8 outputs, the
Alarm State, and the security mode. Clicking on the outputs will change
the state from on to off and vice versa, and the change will be reflected
in the colour of the output icon. If a zone turns on the icon will change
colour. Note that the monitoring of the zone depends on the zone being
programmed to the appropriate zone type. If a zone is not
programmed, i.e. left as Zone Type 0, it will not be monitored.

This will work with any Comfort program, even the default system with
only Zone 1 programmed. Program Zones 2 to 8 to any Zone Type
(except 0) to see that the Zones icons will reflect the real time changes
to the Inputs.

The sample file contents are shown below for reference:

<HTML>

<HEAD>

<TITLE>Comfort Web Server Test Page</TITLE>

</HEAD>
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<BODY background=#FFFFFF>

<H3>

Loading in progress...

<BR><BR>

Please wait until login box appears.

</H3>

<BR>

<APPLET CODE=WebComfort.class ARCHIVE=webcom.jar,cvp.jar
WIDTH=1 HEIGHT=1>

<FONT COLOR=#FFFFFF>

</FONT>

<PARAM NAME="Window1" VALUE="Demonstration,
/comfort/background.gif">

<PARAM NAME="Element1" VALUE="zone,1,0,
/comfort/led_blu.gif,0 , /comfort/led.gif, 120,55,1">

<PARAM NAME="Element2" VALUE="zone,2,0,
/comfort/led_blu.gif,0 , /comfort/led.gif , 170,55,1">

<PARAM NAME="Element3" VALUE="zone,3,0,
/comfort/led_blu.gif,0 , /comfort/led.gif, 220,55,1">

<PARAM NAME="Element4" VALUE="zone,4,0,
/comfort/led_blu.gif,0 , /comfort/led.gif , 270,55,1">

<PARAM NAME="Element5" VALUE="zone,5,0,
/comfort/led_blu.gif,0 , /comfort/led.gif, 320,55,1">

<PARAM NAME="Element6" VALUE="zone,6,0,
/comfort/led_blu.gif,0 , /comfort/led.gif, 370,55,1">

<PARAM NAME="Element7" VALUE="zone,7,0,
/comfort/led_blu.gif,0 , /comfort/led.gif, 420,55,1">

<PARAM NAME="Element8" VALUE="zone,8,0,
/comfort/led_blu.gif,0 , /comfort/led.gif, 470,55,1">

<PARAM NAME="Element9" VALUE="output,1,1,
/comfort/led_ora.gif,2 , /comfort/led.gif, 120,125,1">

<PARAM NAME="Element10" VALUE="output,2,3,
/comfort/led_ora.gif,4 , /comfort/led.gif, 170,125,1">

<PARAM NAME="Element11" VALUE="output,3,5,
/comfort/led_ora.gif,6 , /comfort/led.gif, 220,125,1">

<PARAM NAME="Element12" VALUE="output,4,7,
/comfort/led_ora.gif,8 , /comfort/led.gif, 270,125,1">

<PARAM NAME="Element13" VALUE="output,5,9,
/comfort/led_ora.gif,10 , /comfort/led.gif, 320,125,1">

<PARAM NAME="Element14" VALUE="output,6,11,
/comfort/led_ora.gif,12 , /comfort/led.gif, 370,125,1">
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<PARAM NAME="Element15" VALUE="output,7,13,
/comfort/led_ora.gif,14 , /comfort/led.gif, 420,125,1">

<PARAM NAME="Element16" VALUE="output,8,15,
/comfort/led_ora.gif,16 , /comfort/led.gif, 470,125,1">

<PARAM NAME="Mode1" VALUE="120, 195,
/comfort/disarm_small.gif, /comfort/away_small.gif,
/comfort/night_small.gif, /comfort/day_small.gif,
/comfort/vacation_small.gif, 1">

<PARAM NAME="State1" VALUE="120, 245,
/comfort/base.gif, /comfort/idle.gif, /comfort/trouble.gif,
/comfort/alert.gif, /comfort/alarm.gif, 1">

<PARAM NAME="Arm1" VALUE="120, 290,
/comfort/disarm.jpg, 170, 290, /comfort/away.jpg,220, 290,
/comfort/night.jpg,270, 290, /comfort/day.jpg,320, 290,
/comfort/vacation.jpg, 1">

<FONT color=#000000>

Sorry, your browser doesn't support java.</FONT>

</APPLET>

</BODY>

</HTML> 

This file is saved in sampleindex.htm as well as index.htm, and is also
found in your CWM CD-ROM
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A More Complex Example

The devices controlled in the example above are 5 banks of fluorescent
lights, 3 airconditioners, a water boiler for drinking water, 4 Motion
detectors, and 3 doors to each of the rooms. The current Security Mode
and the alarm state are shown below the main image. The gray window
at the bottom displays the alarm and restore messages from Comfort. 

The lights shown in the example are controlled by the TWS01 Lighting
Control module which has a main-rated relay to switch the light and a
current sensor to sense the state of the light connected to a two way
manual switch. The radio and Water heater are controlled by X10
modules. The design in the example is shown below:

<HTML>
<HEAD>
<TITLE>Comfort Web Server</TITLE>
</HEAD>
<BODY background=#FFFFFF>
<H3>
Loading in progress.<BR>
Please wait patiently.
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</H3>
<BR>
<APPLET CODE=WebComfort.class ARCHIVE=webcom.jar,cvp.jar
WIDTH=1 HEIGHT=1>
<FONT COLOR=#FFFFFF>
</FONT>
<PARAM NAME="window1" VALUE="Cytech Office,
/comfort/background_office.gif">
<PARAM NAME="element1" VALUE="zone,4,0, /comfort/door_re1.gif,0 ,
/comfort/door_re0.gif, 19,376,1">
<PARAM NAME="element2" VALUE="zone,5,0, /comfort/detect1.gif,0 ,
/comfort/detect0.gif , 120,278,1">
<PARAM NAME="element3" VALUE="zone,16,0, /comfort/door_re1.gif,0 ,
/comfort/door_re0.gif, 195,375,1">
<PARAM NAME="element4" VALUE="zone,14,0, /comfort/detect1.gif,0 ,
/comfort/detect0.gif , 230,20,1">
<PARAM NAME="element5" VALUE="zone,15,0, /comfort/detect1.gif,0 ,
/comfort/detect0.gif , 230,365,1">
<PARAM NAME="element6" VALUE="zone,13,0, /comfort/detect1.gif,0 ,
/comfort/detect0.gif , 150,160,1">
<PARAM NAME="element7" VALUE="zone,1,17, /comfort/airc_n1.gif,18 ,
/comfort/airc_n0.gif , 300,372,1">
<PARAM NAME="element8" VALUE="zone,2,17, /comfort/airc_n1.gif,18 ,
/comfort/airc_n0.gif , 420,372,1">
<PARAM NAME="element9" VALUE="zone,3,19, /comfort/airc_n1.gif,20 ,
/comfort/airc_n0.gif , 78,372,1">
<PARAM NAME="element10" VALUE="zone,6,11,
/comfort/lightfl_h1.gif,12 , /comfort/lightfl_h0.gif , 60,30,1">
<PARAM NAME="element11" VALUE="zone,7,13,
/comfort/lightfl_h1.gif,14 , /comfort/lightfl_h0.gif , 60,230,1">
<PARAM NAME="element12" VALUE="zone,8,15,
/comfort/light3fla_v1.gif,16 , /comfort/light3fla_v0.gif , 360,70,1">
<PARAM NAME="element13" VALUE="zone,9,128,
/comfort/light3fl_v1.gif,129 , /comfort/light3fl_v0.gif , 240,75,1">
<PARAM NAME="element14" VALUE="zone,10,130,
/comfort/light3fla_v1.gif,131 , /comfort/light3fla_v0.gif , 480,70,1">
<PARAM NAME="element15" VALUE="x10,P,6, 45,
/comfort/heater1.gif, 46, /comfort/heater0.gif , no,540,370,1">
<PARAM NAME="element16" VALUE="x10,P,1, 41,
/comfort/radio1.gif, 42, /comfort/radio0.gif , no,32,180,1">
<PARAM NAME="cam1" VALUE="30, 150, /comfort/webcam.gif,
10.0.0.22,80, 255.255.255.0, 8080,1">
<PARAM NAME="element17" VALUE="zone,0,0,
/comfort/mode.gif,0 , /comfort/mode.gif , 10,430,1">
<PARAM NAME="mode1" VALUE="80, 430, /comfort/disarm.gif,
/comfort/away.gif, /comfort/night.gif, /comfort/day.gif, /comfort/vacation.gif,
1">
<PARAM NAME="element18" VALUE="zone,0,0,
/comfort/status.gif,0 , /comfort/status.gif , 125,430,1">
<PARAM NAME="state1" VALUE="195, 430, /comfort/base.gif,
/comfort/idle.gif, /comfort/trouble.gif, /comfort/alert.gif, /comfort/alarm.gif, 1">
<PARAM NAME="element19" VALUE="zone,0,220,
/comfort/stop.gif,0 , /comfort/stop.gif, 535,425,1">
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<PARAM NAME="arm1" VALUE="310, 425, /comfort/disarm.gif,350,
425, /comfort/away.gif,390, 425, /comfort/night.gif,430, 425,
/comfort/day.gif,470, 425, /comfort/vacation.gif, 1">
<FONT color=#000000>
Sorry, your browser doesn't support Java.</FONT>
</APPLET>
</BODY>
</HTML>

To try this example, refer to the section on Uploading Files to CWM.
Rename the index.htm file as sampleindex.htm. Look for the file
sampleoffice.htm and rename it to index.htm. Close the browser
window and access the IP address of CWM again.

The Input and Output assignment are shown below. A Local Expansion
Module LEM01 is needed as there are 16 inputs and outputs (not all
used)

Zones Description Zone Type Remarks
1 Office Aircon 1 8 Current Sensor
2 Office Aircon 2 8 Current Sensor
3 Outside Aircon 8 Current Sensor
4 Main Door 2 Door Contact
5 Outside Office Movement 5 PIR
6 Store Light 8 Current Sensor
7 Outside Light 8 Current Sensor
8 Office Light 2 8 Current Sensor
9 Office Light 1 8 Current Sensor
10 Office Light 3 8 Current Sensor
11 Unused
12 Unused
13 Outside Office Movement 5 PIR
14 Office Right Movement 5 PIR
15 Office Left Movement 5 PIR
16 Office Door 1 Doorcontact
Output Description
1 Office Aircon 1 IR
2 Office Aircon 2 IR
3 Outside Aircon IR
4 Unused
5 Unused
6 Store Light
7 Outside Light
8 Office Light 2
9 Office Light 1
10 Office Light 3
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Programming Steps
The Comfort system to be used with the CWM should be programmed
and debugged before trying to access it with CWM. 

The first step with CWM web page design is to get a background file.
This can be done using any Paint program, including Windows paint or
Paint Shop Pro, or a Floor Plan design program. Only include the static
elements of the floor plan, leaving gaps for the doors, windows and
gates which are monitored or controlled by Comfort. However, note
that the CWM allows for about 3 MB for graphics and web page design.

Once the background image has been drawn, upload the file to CWM as
instructed in the previous section, then load the web page by typing
the IP address in the Explorer URL bar. The next step is to try to locate
the various graphic elements like doors, windows, motions detectors,
lights, and other appliances on the screen over the background image.
A library of image files is provided on the CD-ROM and is also
preloaded in the ../comfort subdirectory. If no suitable images are
included, you will have to generate your own images using any drawing
program, and upload the image files one by one to the specified
directory. The file format for the image files should be .jpg or .gif only.
Keep the image size as small as possible in order to reduce the time
required to load the page, and also to save memory in CWM. Avoid
unnecessarily high colour depth.

It is highly recommended to do the design in an iterative manner,
uploading and testing after a few elements have been added. Be
careful that all image files used in the index.htm file is available in the
specified path, otherwise the entire image will not be seen.

It is not necessary to connect Comfort to the CWM to program the
CWM web page.

Display of X,Y, Coordinates
A tool is provided which aids in determining the location of the
elements on the page. This causes the coordinates to be displayed in
the Java Console in Java-enabled browsers when the mouse is clicked
on the page. In Internet Explorer, click on View -> Java Console. In
Netscape, select Tasks -> Tools -> Java Console. The following line
must also be inserted in the index.htm file

<PARAM NAME = “MouseClicked”  Value = “On”>

This line is to be inserted together with the rest of the parameter
setting lines. The word “MouseClicked” is case-sensitive.

When the web page design has been completed, this line may be
removed in desired to prevent users from seeing the coordinates on
every mouse click.

Remember that each image is inserted with the top left corner at the
set coordinates.
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Image Library

To help in developing the CWM graphics elements, a library of .gif icons
are supplied on the CWM CD-ROM. The file names give an indication of
the content and orientation of the icons, for example, door_ln1.gif

means a door which opens on the Left and to the North. The size
of each icon is also shown in the table below, to help when positioning
the icon on the background. Remember that the image is referenced
from its top left corner.

Icon Filename Icon Filename
Night.gif
30 x 30

Away.gif
30 x 30

Day.gif
30 x 30

Vacation.gif
30 x 30

Disarm.gif
30 x 30

stop.gif

Led0.gif
30 x 30

Led_blu.gif
30 x 30

Led_gre.gif
30 x 30

Led_ora.gif
30 x 30

Led_red.gif
30 x 30

Led_yel.gif
30 x 30

Radio0.gif
25 x 30

Radio1.gif
25 x 30

Lightcir_0.gif
20 x 20

Lightcir_1.gif
20 x 20

Heater0.gif
30 x 30

Heater1.gif
30 x 30

Aircsm_s0.gif
39 x 21

Aircsm_s1.gif
42 x 21

Aircsm_n0.gif
39 x 21

Aircsm_n1.gif
42 x 21

Aircsm_w0.gif
21 x 39

Aircsm_w1.gif
21 x 42

Aircsm_e0.gif
21 x 42

Aircsm_e1.gif
21 x 42

Airc_s0.gif
60 x 30

Airc_s1.gif
60 x 30
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Icon Filename Icon Filename
Airc_n0.gif
60 x 30

Airc_n1.gif
60 x 30

Airc_e0.gif
30 x 55

Airc_e1.gif
30 x 60

Airc_w0.gif
30 x 55

Airc_w1.gif
30 x 60

Aircon_a0.gif
30 x 30

Aircon_a1.gof
30 x 30

Curtain_a0.gif
30 x 30

Curtain_a1.gif
30 x 30

Curtain_b0.gif
30 x 30

Curtain_b1.gif
30 x 30

Door_a0.gif
30 x 30

Door_a1.gif
30 x 30

Door_b0.gif
30 x 30

Door_b1.gif
30 x 30

Door_c0.gif
30 x 30

Door_c1.gif
30 x 30

Fan_a0.gif
30 x 30

Fan_a1.gif
30 x 30

Fire_a0.gif
30 x 30

Fire_a1.gif
30 x 30

Fire_b0.gif
30 x 30

Fire_b1.gif
30 x 30

Gate_a0.gif
30 x 30

Gate_a1.gif
30 x 30

Indicator_a0.gif
30 x 30

Indicator_a1.gif
30 x 30

Lamp_a0.gif
30 x 30

Lamp_a1.gif
30 x 30

Lamp_b0.gif
30 x 30

Lamp_b1.gif
30 x 30

Light_a0.gif
30 x 30

Light_a1.gif
30 x 30

Light_dim.gif
30 x 30

Light_bright.gif
30 x 30

Pir_a0.gif
30 x 30

Pir_a1.gif
30 x 30
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Icon Filename Icon Filename
Tv_a0.gif
30 x 30

Tv_a1.gif
30 x 30

Window_a0.gif
30 x 30

Window_a1.gif
30 x 30

Window_b0.gif
30 x 30

Window_b1.gif
30 x 30

Lightfl_h0.gif
60 x 30

Lightfl_h1.gif
60 x 30

Lightfl_v0.gif
30 x 60

Lightfl_v1.gif
30 x 60
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Section 5Programming Comfort

Comfort Programming
The Comfort system should be programmed in the usual way, defining
the security zones, sensors and switches connected to the inputs, and
the Control menu for control of the home appliances. Refer to the
Comfort Engineer Manuals, worksheet and Programming with Action
codes for programming information. As mentioned, the Java Applets
send commands to Comfort using Responses, and monitor the state of
Zones, outputs, X10, alarm state, and security mode.

The id of the UCM connected to the CWM must be set correctly, as well
as the number of UCMs in the system (Location 1672). Up to 8 UCMs
can be connected to Comfort. 

The only additional programming required for CWM is to set up a Home
Control menu item for Dial Up (only for modem dial-up). This will tell
CWM to dial up to the ISP using the telephone number programmed
during the CWM Configuration, and log in using the programmed user
name and password.

Dial Up Home Control Menu
In Home Control menu (Engineer Menu 3,1), set up a spare Control
key, say 9 with the following settings

Key Description Action
K

Action Words Resp
(0 to

*)
Description (0-255) (0-255) (0-255) (0-127)

9 Word 1 Word 2 Word 3 Word 4 0 Off 229 220
(0-255) (0-255) (0-255) (0-255) 1 On 230 219
177 56 2
Dial Up 3

4
5
6
7
8

Location for Feedback Input 9
*

Set up an unused Response, say 219 and 220 to do dial up and
disconnect

Response 219:

138,2, 18, 255 Dial up for id=18, (i.e. UCM id 2)

Response 220 

138,0, 18, 255 Disconnect id=18 (i.e. UCM id 2)
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Action 138,2,18 will cause the CWM to send the dialup command to
CWM when the telephone line is free. This applies when the modem is
connected to Comfort’s TEL OUT line. Comfort monitors the incoming
telephone line and only sends the command when the line is not used.

Action 138,1,18 causes the CWM with id=18 to send the dial up
command to the CWM immediately. Use this action when the Modem is
on a dedicated line or on another telephone line, and not connected to
TEL OUT.

Action 138,0,18 tells CWM to disconnect or end the call.

The UCM id used in response 138 refers the id of the module on the
RS485 bus where 17 = UCM 1, 18 = UCM 2, ..., 24 = UCM 8. A special
type of UCM is used to interface to the CWM.

An icon can be placed on the CWM screen to disconnect from the
Internet using the “zone” element, e.g.

<PARAM NAME=”Element#”   VALUE=”zone, 0, 253,
/comfort/hangup.gif, 0,  /comfort/hangup.gif, 350, 20, 1”>

Element# gives the element number with # being a numeric value. The
zone value specified is 0 which means that there is no feedback from
Comfort. The Response On number is 253 which in the above example
tells Comfort to disconnect the CWM from the Internet. The image file
hangup.gif is displayed. If not commanded to disconnect, the CWM will
automatically disconnect the dial-up modem after a duration of
inactivity as specified in the setup script.

Instead of using the keypad to program, one can also use Comfigurator
to program the dialing up and hanging up for the home control menu.
To do so, create a response using the UCM Dial Up command found
under the Output tab in Response Wizard.

The responses mentioned earlier can be replicated using:

• UCM 2 DialOut

• UCM 2 Hangup

• UCM 2 DialOutWhenFree
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Section 6Troubleshooting

Login Window does not appear
After typing the IP address of CWM in the URL window, the login
window should appear. 

If it does not, it could be due to incorrect IP address or the index.html
file is missing or wrongly programmed, or the network cable may have
been connected after the CWM was powered up. Always connect the
network cable to the CWM RJ45 socket before connecting power to the
CWM. If the CWM is powered on before the Network is connected, its
network drivers will not be loaded and the network connection will NOT
work.

Login Window is cleared after entering Code
If the Login window appears (like above picture) , and the correct code
is entered and transmitted, but the Login Window is cleared, without a
“correct code” or “Invalid Code” message, Comfort or the CWM may
not be connected correctly. The causes of this could be CWM UCM ID
(SW7) not set to the correct ID, or Comfort Location 1672 (Modules
and Settings Screen in Comfigurator) not set to the correct number of
UCMs, or the CWM is not switched on, or the network cable may have
ben connected after the CWM was powered up.

Take note that over the Internet there could be up to 10 to 50 seconds
delay (depending on Internet traffic) between the time the login code is
entered and the “OK” message is received.

Web Page does not appear
If the Login window does appear, and the correct code has been
entered and acknowledged by CWM, but the expected background
image does not appear, the most likely cause is that one or more of the
image files specified in the index.htm file is missing, or the file name
does not match the name specified in the file. Check all the image file
names in the index.htm file against the actual files in the specified
image folder.

Take note that over the Internet there could be 10 to 50 seconds delay
before the CWM home page appears, depending on the speed of the
connection, Internet traffic and the size of the images.
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IP Address Lost
Use the program cwmsetup.exe to discover the IP address of the CWM.

CWM Files have been Corrupted
If at any time, the CWM files might have corrupted such that one is
unable to access the CWM, the files in the CWM might have been
corrupted. To reset the CWM back to factory default, program a
response with the following action codes:

197,19,82,69,83,69,84, 67,79,78,70,255

This assumes that you are sending a string of “82,69,83,69,84,
67,79,78,70” via RS232 to ID19 (i.e. UCM ID = 3).

Alternatively, this can be done by Comfigurator by setting the response
as:

Send RS232 3 52,45,53,45,54,43,4F,4E,46

Triggering this response will then reset the CWM, reverting it back to
the default configuration. However, the index.html file and other user
files will still remain intact.

Password Lost
If at any time, the password may have changed accidentally. To reset
the password for the CWM, program a response with the following
action codes:

197,19,82,69,83,69,84,80,87,68,255

This assumes that you are sending a string of
“82,69,83,69,84,80,87,68” via RS232 to ID19 (i.e. UCM ID = 3).

Alternatively, this can be done by Comfigurator by setting the response
as:

Send RS232 3 52,45,53,45,54,50,57,44

Triggering this response will then reset the password for the CWM,
reverting it back to the default password.

TCP Pass-Through Port Does Not Work
If the CWM is working correctly, but the assigned TCP Pass-through
port does not work, the problem is probably due to a firewall blocking
the ports. Configure the firewall to allow the port assigned to TCP
Passthrough (default 10001)
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Version History
UCM/CWM 5.70 (29 March 2005)

1. Engineer Code needed to perform changes to the configuration
settings in CWM.

2. Cytech’s dynamic IP system established.

UCM/CWM 5.63 (25 September 2003)
1 Engineer Code enabled and disabled will send PS01/PS00 to

enable and disable TCP Pass-through port operation. PS00/01
report does not require a login to allow Pass-through operation to
be independent of the CWM web page. Login will be required
during the TCP Pass-through operation e.g. for upload and
download.

2 RS232 Commands for corresponding UCM version have been
added, including Vocabulary Download

UCM/CWM 5.12 (19 November 2001)

Initial Release
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Limited Warranty
Cytech Technology Pte Ltd. provides a warranty for a period of 12
months from the date of purchase. This warranty covers defects in
materials and workmanship under conditions of normal use by the
original buyer only. In the case of any breach of such warranty, Cytech
Technology Pte Ltd. shall either repair or replace the defective
equipment upon return of the equipment to its repair center at the
purchasers own expense.

Cytech Technology Pte Ltd. is not liable under any circumstances for
any damages, loss of anticipated revenue, loss of time or any other
losses resulting from the purchase, installation, use or failure of this
product.
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